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This book is dedicated to Brandon Creasey. 

The memories are so wonderful, but the pain is still with us.



About the Author
I’ve been a professional photographer on and o¡ for almost 60 years. I ¢rst started working in 
photography in 1963 at the Army Aviation Test O�ce at Edwards Air Force Base in Edwards, 
California. I shot on glass plates using the Fairchild Flight Analyzer, developed the plates, 
and made contact prints. It was crude but an interesting ¢rst introduction to photography.

A few years later, I joined the Peace Corps and spent several years in a Venezuelan ¢sh-
ing village and the Amazon jungle in Ecuador. It was early in my Peace Corps service that I 
acquired my ¢rst SLR and became thoroughly engrossed in photography.

A�er my tour in the Peace Corps, I went to the New York Institute of Photography in New 
York City when it was a resident school. A�er a short time in Manhattan, where I shot all 
over the city, I acquired a diploma in Commercial Photography and headed o¡ to my home in 
California.

Throughout the time I was working on my baccalaureate degree and going to graduate 
school, I shot weddings that paid for my education. When I had time o¡ from school, I 
worked in a small trailer I converted into a dark room, where I processed B&W ¢lm and made 
enlargements.

I began teaching secondary school a�er ¢nishing my university degree and was given a class 
to teach in photography. For more than 30 years, I’ve been involved in teaching photography 
and digital image editing. I owned a digital imaging and photo ¢nishing company for more 
than 16 years. That’s where much of my work was spent on the back end of photography. 

Photography has never been a regular job for me, but it’s been a delight and a great love. I 
wouldn’t want to spend all my time in a full-time job in photography, and I’m quite certain 
that is the reason it’s still a ¢rst love for me.

In years past, my heroes in the photography world were the great photographers of all time, 
such as Ansel Adams, Richard Avedon, Bert Stern, Irving Penn, Annie Leibovitz, and several 
others. But today, my heroes are the many young people I come across in teaching and some 
young modern-day professionals.

I’ve been working with computers for more than 40 years. I had the luxury of learning appli-
cations slowly over time. When Photoshop 1.0 was introduced, I taught all the tools and 
menu commands and just about all that could be done in Photoshop in my one-day univer-
sity classes at UC Santa Barbara and UCLA. The same went for Adobe Illustrator all the way 
through version 3.2. Today, however, one could spend a week covering just color in Photo-
shop or Illustrator without getting into various tools and commands to handle other edits.

The young people today who can jump into Photoshop 2022 or Elements 2022 and become 
knowledgeable and skilled in a short time are truly my heroes. I’m simply amazed at how fast 
young people learn such a complicated set of applications so quickly. It took me more than 40 
years to know a little about the applications I work with today. If I had to start learning now, I 
just might retire and go ¢shing. 
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The following are some of the other books I’ve authored:

 ■ Photoshop Elements For Dummies 
(coauthored with Barbara Obermeier), 
versions 4 through 2022

 ■ Photoshop Elements All-in-One For 
Dummies (coauthored with Barbara 
Obermier) versions 6 through 13

 ■ Photoshop 3 (coauthored with Bill 
Harrel)

 ■ Photoshop Color Correction (coauthored 
with Don Mason)

 ■ Photoshop Color Correction For Dum-
mies (coauthored with Don Mason)

 ■ Photoshop 4 Instant Expert
 ■ Photoshop Tech Support (coauthored 

with Ken Oyer)

 ■ Adobe Creative Suite (coauthored with 
Kelly Murdock) versions CS – CS5

 ■ Adobe Master Class Illustrator Illu-
minated (coauthored with Barbara 
Obermeier)

 ■ Adobe InDesign Interactive Digital 
Publishing

 ■ Acrobat PDF Bible (versions 3 through 
10)

 ■ Creating Acrobat PDF Forms
 ■ Acrobat PDF Forms Bible (coauthored 

with Angie Okamoto) 
 ■ Acrobat Complete Course
 ■ Adobe Reader 7 Revealed
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INTRODUCTION
Many new photographers typically ask, “What is the best application for editing 
photos?” In online forums, people always respond with Lightroom and Pho-
toshop. Those applications are ¢ne for the photographers who want to spend 
as much time in front of a computer as they do behind the camera. However, 
if you’re the kind of photographer who wants to spend more time behind the 
camera and less time editing photos, then you don’t need the expensive sub-
scription applications. If you’re a scrapbooker; an amateur who likes to take 
family photos; a person who takes many travel, wildlife, or photos of your kid’s 
sports activities; or even a professional wedding or portrait photographer, then 
Photoshop Elements provides you with all the tools you need to perfect images 
that express your vision for how you want the ¢nal photos to appear.

Photoshop Elements comprises three separate applications: the Organizer, the 
Photo Editor, and Adobe Camera Raw. Throughout this book, you ¢nd content 
only on the Photo Editor and Adobe Camera Raw; there is no mention of the 
Organizer. If you want an introduction to Photoshop Elements that covers the 
Organizer, then I suggest you check out Photoshop Elements For Dummies, 
which I coauthored with Barbara Obermeier.

NOTE: When you open the Photo Editor, you see an option to choose one of three separate 
workspaces: Quick, Guided, and Expert. All photo editing addressed in this book is han-
dled in the Expert mode with an occasional reference to using Guided Edits in the Guided 
mode. Therefore, when you see an instruction to open a photo, open the photo in Expert 
mode to be able to follow along with the book.

For several years, Adobe has invested much research and development into 
features using Adobe Sensei technology. (Adobe Sensei is Adobe’s term for 
arti¢cial intelligence.) As you work with tools and menu commands, Photo-
shop Elements uses Sensei technology to learn from the edits you make so 
that it can help you re¢ne adjustments you make to your photo.

When you open the Enhance menu in the Photo Editor Expert mode, you see 
a huge number of commands that perform automated editing tasks. Many of 
these commands use Sensei technology, and Adobe is continuing to improve 
the features to help make editing photos in Elements a one-click operation to 
enable you not to have to think too much about the way to edit your photos.

All the automated features are ¢ne for the novice user. However, to harness the 
real power of Photoshop Elements, you need to use manual editing and move 
away from the automated features. That’s what this book is all about. In the 
chapters ahead, you ¢nd material covering many ways to apply edits to your pho-
tos using the powerful tools in Elements without using automated commands.
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As you delve deeply into Photoshop Elements, you’ll ¢nd it much easier to 
use than other high-end professional photo-editing applications. In this 
book, I show you how to use Elements to edit photos so you achieve profes-
sional results. 

Online content

Accessing the bonus chapters
Your purchase of this book includes two bonus chapters that are accessed 
from your Account page on peachpit.com.

You must register your purchase on peachpit.com to access the bonus 
content:

1. Go to peachpit.com/advancedpse.

2. Sign in or create a new account.

3. Click Submit.

4. Answer the question as proof of purchase.

5. Access the Bonus Content from the Registered Products tab on your 
Account page. 

If you purchased a digital product directly from peachpit.com, your product 
will already be registered. However, you still need to follow the registration 
steps and answer the proof of purchase question before the Access Bonus 
Content link will appear under the product on your Registered Products tab. 

If you encounter problems registering your product or accessing the online 
chapters, go to peachpit.com/support for assistance. 

NOTE: You can find 
video trainings by 
Ted on www.YouTube/ 
TedPadova.
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CHAPTER 8

COMPOSITING IMAGES

Chapter Goals
The ability to composite images is perhaps one of the techniques that best illustrates 
the power of a photo editor. Image compositing is taking two or more images, or tak-
ing different areas in a single image, and bringing them together in another photo 
for either realistic final results or artistic expression. For example, poor uncle Ezekiel 
couldn’t make it last Christmas, but you want him in the family photo, so you take 
one photo of him and add it to your group photo. 

There’s much to consider when compositing images or applying edits to different 
parts of a single image: lighting, perspective, and the right composition to make it 
appear realistic. It’s important to become familiar with certain rules to follow for 
compositing images so the final result looks realistic. You need to be certain subjects 
don’t float on backgrounds, the luminosity and brightness closely resemble all com-
ponents, that the colors match, and hue/saturation levels are similar.

This chapter covers the many considerations you need to make when compositing 
images. You find out how to do the following:

 ■ Become familiar with essentials 
for compositing images

 ■ Understand perspective

 ■ Use Photomerge

 ■ Match color

 ■ Add shadows

 ■ Add photos to high grass
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Knowing Compositing Essentials
There are some important essentials you should know when compositing 
images. As you examine photos, you should carefully look at the images you 
want to bring together. In some cases, it may be next to impossible to bring 
images together. In other cases, you might want to choose one image over 
another because your steps to composite with one image might be easier than 
with another image.

Here are some of the most important essentials for compositing images:

 ■ Perspective: Perhaps the single most important essential for image com-
positing is matching perspective between images. You need to become 
familiar with perspective rules and know something about horizon lines 
and vanishing points. When you have a mismatch in a composite image, 
the viewer immediately can see that the ¢nal image is a fake. People ¯oat-
ing in air, proportion distortions, and unrealistic rotations are immedi-
ately viewed as fake by anyone seeing your ¢nal photos. 

Figure 8.1 shows an exaggerated example, but it gives you the idea of 
issues in perspective. The image on the le� shows the subject ¯oating in 
air and obviously not properly placed in this composite. The problem is 
the horizon line for the background is where the water meets the sky. In 
the subject image on the right of Figure 8.1, the horizon line is at the top of 
the subject’s head, and the composite looks more realistic.

 ■ Resolution: The resolutions of two or more images don’t have to be exact, 
but they should not be extremely di¡erent, such as 72 ppi for one image 
and 300 ppi for the other. When compositing images, choose Image > 
Resize > Image Size. Set identical resolutions for both images. If you need 
some scaling, you can scale images on the composite layers. Be careful 
to not upsize a photo. Increasing resolution can severely degrade your 
images.

 ■ Brightness and contrast: Adjust brightness and contrast a�er bring-
ing one image into another. You can use a Levels Adjustment Layer and 
clip the Adjustment Layer to the layer where you adjust brightness and 
contrast. You should try to get a close match for brightness and contrast 
between images in the composite. 
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FIGURE 8.1 Horizon lines don’t match in the left image; the right image is a closer match of horizon lines.

NOTE:  The amount of noise introduced in photos at higher ISO numbers varies greatly 
between different cameras. Older DSLR (Digital Single Reflex) cameras introduced a lot 
of noise at ISO levels of 1,600 to 3,200. Some of the new mirrorless cameras can have 
much less noise apparent in photos taken at ISO levels of 6,000 to 8,500. To know more 
about the tolerance of noise in photos compared to ISO settings, take a lot of test shots 
and know your camera before attempting to composite images. View your images at 100% 
and look through areas where you see a lot of solid color. That’s usually an area where 
you can find noise if it exists.

 ■ Film grain and noise: The thing to look out for when you try to compos-
ite two or more images is where there’s a lot of disparity in the noise level 
between the images. If you shoot one image at 100 ISO and another at 
12,000 ISO, you’ll see quite a bit of disparity between the noise levels. In 
some cases, you might be able to use a background with high noise levels 
and blur the background to create a little more depth of ¢eld. But when 
using two or more foreground subjects and one has a high noise level 
whereas the other photo is absent of noise, the di¡erence can be easily 
detected.
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 ■ Scale: Scale images appropriately for the perspective. Unfortunately, the 
Elements Photo Editor does not provide an option to create a Smart Object. 
If you have the Elements+ plug-in, you can create Smart Objects. A Smart 
Object enables you to edit a layer nondestructively. 

 ■ Nondestructive editing is particularly important when you scale a layer. 
While compositing, you ¢nd yourself moving, scaling, and observing 
results frequently. You try to ¢nesse adjustments to try to get the best pos-
sible results that appear realistic.

 ■ If you scale a layer in the Photo Editor many times, the image will show 
obvious deterioration. One way to get around the problem is to use File 
> Place and place a photo on a layer in the Photo Editor. When using the 
Place command, the content comes in as a Smart Object. You can then 
scale and move the object many times without data loss. You need to con-
vert the Smart Object to a simple layer using the Simplify Layer command 
in the Layer panel menu before you can apply other edits to the layer. 
However, use the File > Place command and address scaling as one of your 
¢rst edits when compositing images in Photoshop Elements. For more on 
placing ¢les in the Photo Editor, see the section later in this chapter “Plac-
ing Images.”

 ■ Placement: Scaling and matching perspective are very important when 
compositing images. Equally important is where you place an image in the 
composite. You have to continually be aware of the perspective and scal-
ing as you move an image around the canvas.

 ■ Masking: When you create selections and add Layer Masks, the selec-
tions and ultimately the masks should be precise. If you have images 
with shadows, it’s o�en a good idea to include a part or all of a shadow 
in the mask. When you drop the image into a composite, you can edit the 
shadow to make a good ¢t. 

 ■ Lighting: When you bring two or more images together in a composite, 
carefully observe the lighting and, in particular, the direction of the 
lighting. You want to avoid having two images with lighting coming from 
di¡erent directions. In Figure 8.2, you can see the obvious di¡erence in 
lighting between the foreground subject and the background. The back-
ground photo was taken in harsh sunlight. The foreground subject was 
taken with much so�er light. 

 ■ Color balance: One of the last edits you make when compositing images 
is to balance color. Try to get the luminosity, saturation, and color balance 
matching in all images in the composite.

For more information on 
simplifying layers, see 
Chapter 4, “Working with 
Layers.”

For more on clipping 
groups, see Chapter 5, 
“Masking Photos.”
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■ Blending: Be careful when using blending modes. The Darken group 
darkens all layers below the Darken layer. Likewise, the Lighten group 
lightens all layers below the Lighten layer. Areas that are darker make the 
background darker. When you want to use a blending mode to change 
values on one layer, be certain to create a clipping group. The same holds 
true for all Adjustment Layers.

Understanding Perspective
Perhaps the most important consideration to make when compositing images 
is to have your photos in proper perspective. You might be able to get away 
with oversights in brightness, lighting, color, saturation, and so on. However, 
when you’re o¡ with perspective, people squirm a little. They look at your 
photo, and although they might not be able to say what’s wrong with it, they 
just know things aren’t right.

There are many di¡erent types of perspective. You can have one-point 
angular perspective, two-point oblique perspective, and perspectives with 
three, four, ¢ve, and even six vanishing points. Once you get to three-point 
perspectives, things become a little confusing. For all intents and purposes, 
knowing all about one- and two-point perspectives is a good start and will 
handle most of your compositing needs.

FIGURE 8.2 Shadow on the 
subject is much less than 
the background elements.
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Identifying the Horizon Line
One of the ¢rst things you want to do when editing photos is to look at the 
horizon line to determine if a photo needs some straightening with the 
Straighten tool. When you look for images you want to combine in a com-
posite, ¢rst identify the horizon line. If the horizon line is high, it means the 
camera was on a low plane when the shot was taken. Conversely, if the hori-
zon line is low, it means the camera was on a higher plane when the shot was 
taken.

Position of the horizon line has great impact on your ability to composite 
photos. If you need to position a subject very high or very low to main-
tain perspective, you may not be able to use photos you want to use in a 
composite.

It’s very easy to ¢nd the horizon line when you see the sky meeting the land 
(or water) in a photo. In other photos, you may need to search for the vanish-
ing point to ¢nd the horizon line (see Figure 8.3).

FIGURE 8.3 When you identify the vanishing point, it’s easy to find the horizon line.
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Visualizing Vanishing Points
Objects are shaped along a line in a photo toward the vanishing point. Where 
the opposing lines converge, you ¢nd the vanishing point (see Figure 8.4). At 
the vanishing point, you also ¢nd the horizon line.

If you’re standing in front of the horizon line and look ahead, a one-point 
vanishing point would be somewhere along the horizon line. If you look 
straight ahead at the vanishing point, you might see objects and buildings 
falling along lines similar to what you see in Figure 8.5.

FIGURE 8.5 Parallel lines from objects converging at a vanishing point.

You can have more than one vanishing point in an image. A two-point van-
ishing point grid is shown in Figure 8.6. The parallel lines on two sides of an 
object converge at two di¡erent vanishing points.

FIGURE 8.4 A one-point 
vanishing point.

198 PART IV: PHOTO COMPOSITING



Like one-point vanishing points, two-point vanishing points have parallel 
lines from two directions converging at the vanishing points. As shown in 
Figure 8.7, the objects have two sides with lines converging at two vanishing 
points.

When compositing images, you want to know where the horizon line is in 
your images. When you have di�culty ¢nding a horizon line, try to draw 
lines that converge to locate the horizon line.

Using Perspective When Compositing Images
When you have two images that you want to bring together on a single can-
vas, you start by creating a selection and Layer Mask on one or both images, 
depending on the content and what you want in your ¢nal photo. This exam-
ple uses a Layer Mask on one image and brings it into the second image.

Finding the Horizon Lines
A�er you create a Layer Mask, ¢nd the horizon lines in both images. I’m 
starting with my photo with the mask. If you have a Layer Mask, press Shi� 
and click on the mask to hide it. If the horizon line is easy to see, as shown in 
Figure 8.8, draw a line where you see the horizon line.

FIGURE 8.6 A two-point vanishing 
point grid.

FIGURE 8.7 Objects with 
lines converging to form 
two vanishing points.
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When you use the line tool, a new layer is automatically created. You can 
later dismiss the layer when adding the photo to another photo. Save this 
photo by choosing File > Save As and save the photo as a .psd ¢le including 
layers and a new name before moving on.

Open the second image. In my example, Figure 8.10 is the target image where 
I’m creating the composite. Locate the horizon line in this image. In my example 
photo, the horizon line is not as easy to detect. I draw two lines along the 
base of the trees on either side of the photo. Where the lines converge is fairly 
close to the horizon line, as you can see in Figure 8.9. Each line creates a new 
layer. When you’re sure the lines are as you want them, hide all other layers 
and choose Merge Visible from the Layer panel menu. Only the line layers are 
merged. Show all layers and save the ¢le as a .psd including layers.

FIGURE 8.8 Locate the 
horizon line in the first 
image.

FIGURE 8.9 Locate the 
horizon line by drawing 
lines that converge at the 
horizon.
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Placing Images
Next, you want to create a Smart Object from the ¢le you’re importing into 
the ¢nal composite image. 

Return to the ¢rst photo and hide all layers but the layer with the mask. 
Return to the composite target image and choose File > Place. When you 
place a photo in the Photo Editor, the ¢le comes in as a Smart Object, which 
means you can scale the photo any number of times without destroying data. 

As you can see in Figure 8.10, the placed photo comes in at the center of the 
image. Notice the horizon line for this photo is above the subject’s head. Click 
the green check mark to commit the placement of the image. Notice that plac-
ing photos with Layer Masks retains the masked area. The placed image does 
not have a mask. The masked-out areas are deleted when you place the ¢le.

Scaling Images
The next task is to scale and place the image in position. You can’t use ¢l-
ters in the Filter menu or menu commands in the Enhance menu on a Smart 
Object. Therefore, you need to spend time deciding precisely what scaling 
you want for the photo. A�er scaling an image, you need to rasterize the layer 
by choosing Simplify Layer in the Layers panel menu. 

In my example, I know the horizon line for the placed image is slightly above 
the subject’s head. The horizon line is identi¢ed in the target image; there-
fore, I ¢rst need to move the placed image’s horizon line so it matches with 
the target image’s horizon line. When the placement looks good, press Ctrl/z 

FIGURE 8.10 A file placed in 
the target composite image.
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+ T to scale the image. Press Alt/Option + Shi� and drag a corner handle to 
size the photo. When you use Alt/Option, the photo scales up or down while 
maintaining the placement on the horizon line. Pressing the Shi� key con-
strains the sizing proportionately. In Figure 8.11, you can see the ¢nal scal-
ing of the photo I placed in my target composite image. Compare Figure 8.10 
with Figure 8.11. The subject looks more natural in respect to walking on the 
ground rather than ¯oating above the ground.

TIP:  If you want to scale the placed photo, you can maintain the position on the horizon 
line as you scale up or down. First, press Alt/Option and click the tiny icon in the center of 
the image. This is an anchor point. Move the anchor point to where the horizon line inter-
sects with the photo. Press the Alt/Option key and scale the image by dragging a corner 
handle. The image is scaled from the anchor point, thereby maintaining the same position 
on the horizon line.

At this point, you can hide the lines layer and begin to work on brightness/
contrast and color matching. You also could look at creating a little shadow 
at the subject’s feet and even a shadow for the ¢gure, but I don’t go into that 
detail here.

FIGURE 8.11 Drag a 
handle to scale a photo 
while maintaining the 
placement.
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Using Photomerge Guided Edits
In the Guided Edits panel, there are six separate guided edits you can choose 
from for compositing images. That should give you an idea for how important 
photo compositing is.

The Guided Edits for Photomerge can provide for some quick photo composit-
ing. In some cases, the ¢nal edits are very satisfactory. In other cases, you 
might want to also do some manual edits when merging photos. However, 
sometimes you may want to avoid a Guided Edit altogether and perform all 
steps manually. It all depends on the images you use and the results you want.

Using Photomerge Compose
The ¢rst Guided Edit is the Photomerge Compose item. This Guided Edit 
walks you through steps to bring objects from one photo into another photo. 
Open two ¢les in the Photo Editor. In the Photo Bin, you should see only two 
photos.

Open the Guided Edit panel and click the Photomerge tab. Click the ¢rst item 
where you see Photomerge Compose. The ¢rst screen that opens asks you to 
drag and drop the ¢le from which you intend to extract a subject or object. 

Unfortunately, selections in the Guided Edit are very crude. You can muddle 
through the options for selecting and extracting a subject, but in the Photo 
Editor, you have so many more re¢ned tools and methods for creating selec-
tions and extracting subjects. All in all, you’re better o¡ following manual 
methods than using this Guided Edit for compositing images.

Using Photomerge Exposure
You can use Photomerge Exposure in two ways. First, you can bring two 
totally di¡erent photos together in a composite and match exposures. The 
second option enables you to merge two or more identical photos. This fea-
ture is similar to merging HDR photos in Photoshop.

High Dynamic Range Photos
An HDR photo is a High Dynamic Range image. Many 
high-end cameras have an HDR setting that involves 
a rapid firing of three or more images shot at different 
f-stops. If your camera doesn’t have an HDR option in 
the menu, you may have choices for bracketing photos.

HDR images are comprised of at least one photo for 
the highlights, one for the shadows, and one for the 

midtones. This essentially increases the dynamic 
range and enables you to capture highlight and 
shadow data that otherwise would not be captured 
in a single photo. If you have three photos taken at 
different f-stops, you need to merge the photos into 
a single image. Unfortunately, Photoshop Elements 
doesn’t include a merge HDR option.
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Merging Different Photos
Let’s ¢rst take a look at merging two completely di¡erent photos. As a general 
rule, I wouldn’t recommend using the Guided Edit for this kind of merge. You 
can match exposures much better manually than when using the Guided Edit.

You have an option for choosing Automatic or Manual. If you have two com-
pletely di¡erent photos, the Automatic setting lays one photo on top of the 
other and creates a double exposure look. 

If you choose Manual, you can cut out one photo and merge it with the target doc-
ument. In the Photomerge Exposure panel, click Manual at the top of the panel. 
Click the Pencil tool and draw around the object you want to add to another 
photo. You don’t have to paint inside the object. Just draw an outline around it. 

Painting the image for the cutout is very crude. You can do so much better with 
selection tools in the Photo Editor. For compositing images where you take a 
cutout from one image and add it to another, it’s best to avoid this Guided Edit 
for compositing.

You may, however, ¢nd a di¡erent bene¢t for using this Guided Edit. Let’s say 
you have two very di¡erent photos. You don’t want to superimpose them; you 
just want to match the brightness in one image with another image. As a work-
around, you could o¡set the photos so they don’t overlap.

As an example, take a look at Figure 8.12. This photo has a reasonably good 
exposure, and the brightness values appear quite nice. Now look at Figure 
8.13. This photo is a little dark, and the overall exposure isn’t quite as good as 
the photo in Figure 8.12.

FIGURE 8.12 Photo with a 
reasonably good exposure.
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If I take both these photos and bring them into the Photomerge Exposure 
edit, the ¢nal result is two photos superimposed. But I don’t want to merge 
the photos; I simply want to match the exposure,

To set up the ¢les, ¢rst size them to the same resolution and physical size by 
using the Image > Resize > Image menu command. A�er you size the photos 
to the same size, resize the canvas area. On one photo, you want to add more 
canvas (double the width of the photo) to the right. On the other photo, you 
want to add the same amount of canvas area to the le�. A�er I’ve added more 
canvas area to the photos, they look like Figure 8.14.

As you might suspect, a�er using the Guided Edit, when the photos are 
merged, they won’t superimpose one on top of the other. Each photo merges 
with the empty space added by resizing the canvas.

With the two photos open in the Photo Editor, click the Guided tab to open 
the Guided Edits. Click the Photomerge tab and click Photomerge Exposure. 
As you can see in Figure 8.15, the photos appear adjacent to each other. Use 
the tools in the Photomerge Exposure panel to re¢ne the brightness. When 
you are ¢nished editing, click Next and click Expert to open the merged pho-
tos in the Photo Editor. At this point, if you want the photos saved separately, 
duplicate the image and crop each one to retain the image you want to save. 

As you can see in Figure 8.16, the photo on the right more closely matches the 
overall brightness of the photo on the le�. At this point, you might add some 
re¢nement by adding a Levels Adjustment layer to re¢ne the brightness.

FIGURE 8.13 Photo that’s a 
bit underexposed.
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FIGURE 8.14 More canvas area added to the two photos.

FIGURE 8.15 Photos appearing adjacent to each other in the Guided Edit Exposure panel.

If you need a quick ¢x for matching exposure between documents, this 
Guided Edit may be helpful.
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Merging Photos for an HDR Effect
Remember, an HDR photo is one derived from three or more exposures of 
the same scene. You use your camera to shoot a scene underexposed, over-
exposed, and normal exposure. The photos can then be merged using the 
Photomerge Exposure Guided Edit. For this kind of edit, you don’t have a 
manual method to achieve the same result. If you shoot three exposures of 
the same scene, you must use this Guided Edit to merge the photos when 
using the Photo Editor. 

Figure 8.16 shows the three photos I use in this example. You can use ¢ve or 
seven photos. Whatever bracketing your camera accommodates is what you 
can use to merge the photos. Typically, three photos work quite well for most 
images.

In Figure 8.16, the photo on the le� was shot with an average exposure. The 
middle photo was an overexposed photo capturing as much detail as possible 
in the highlights. The photo on the right was underexposed to capture as 
much detail as possible in the shadows.

With the three photos open in the Photo Editor, click the Guided Edit 
tab. Click Photomerge Exposure.

When you click Photomerge Exposure, the Guided Edit merges the 
three photos. The default option is Automatic, and this option is typi-
cally your best choice for merging photos for an HDR e¡ect.

The Guided Edit panel, shown in Figure 8.17, provides some options 
for tweaking the composite image. When merging photos for an HDR 
e¡ect, it’s best to avoid using any settings in the Guided Edit panel. 
Click Next (see Figure 8.17). On the next screen, click Expert to return 
to the Expert editing mode.

You may want to tweak the overall exposure using a Levels Adjust-
ment Layer and add some sharpening. 

Figure 8.18 shows the photo shot with an average exposure. Figure 
8.19 shows the same photo shot as an HDR and merged using the Pho-
tomerge Exposure Guided Edit. Notice the clouds have more detail in 
the HDR photo, and you also ¢nd much more detail in the shadows in 
the HDR photo.

FIGURE 8.16 Three photos 
shot for creating an HDR 
image.

FIGURE 8.17 The Photomerge Expo-
sure panel.
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Using Photomerge Faces
This Guided Edit is just a fun type of edit you use to distort faces and create some 
goofy photos as pranks. You can play with it if interested. For the purposes of this 
book, we’ll look at some more serious kinds of edits that can help professionals 
and serious amateurs. 

FIGURE 8.18 The merged 
HDR files.

FIGURE 8.19 The final HDR 
image after editing the 
merged files in the Camera 
Raw Editor.
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Photomerging a Group Shot
When taking group shots, you o�en ¢nd one person smiling in one photo 
and the same person frowning in another photo, one person looking away 
from the others, or one individual who has their eyes open in one photo and 
closed in another photo. An easy ¢x to these kinds of problems is to use the 
Photomerge Group Shot Guided Edit. It’s not perfect and sometimes doesn’t 
work well, but in some cases, you may ¢nd it useful.

Figure 8.20 shows a nice photo of a group of people. However, the man on the 
le� is not looking at the individual who is talking.

If you have a second photo showing the individual looking in a di¡erent 
direction more consistent with the other subjects, you can merge the ¢les. 
Use the second image as your ¢nal photo. Move the subject with the face 
forward from another photo to the ¢nal.

Open both images in the Photo Editor. Click the Guided Edit tab and click 
on the Photomerge Group Shot Guided Edit thumbnail. Drag the ¢nal image 
to the right placeholder. Select in the Photo Bin the image with the correct 
posture. Use the Pencil tool to draw around the subject in the le� image in 
the Photo Bin. You can change the size of the pencil, and you can erase any 
unwanted selection. A�er you draw with the Pencil tool, you see a dynamic 
preview of the results, as shown in Figure 8.21. 

Click Next and either save the photo or open it in Expert mode. In Figure 8.21, 
you can see the results of merging the photos. However, before I end this 
editing session, there’s one more problem with the photo on the right. I need 
to do something about that sky. As you can see in the original image in Fig-
ure 8.20, the highlights in the sky are blown out. 

FIGURE 8.20 Group photo 
with one individual who’s 
not looking at the speaker.
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Editing Skies
Quite o�en you can ¢nd photos that look good with foregrounds, but there 
are problems with the highlights, particularly with skies. You can see that 
the photo in Figure 8.20 has no detail in the sky. I need to add some color in 
the sky and perhaps add some clouds. Making these edits is quite simple.

You can edit a sky in a few di¡erent ways. You can copy a photo with a sky 
that will work well with your target image, or you can add a ¢lter to create 
arti¢cial skies.

Create a selection of the sky and press Ctrl/z + J to create a new layer of 
just the selected area. Once you have a selection, you can copy a sky from 
another photo and choose Edit > Place into Selection.

If using a ¢lter, click the foreground color swatch to open the Color Picker 
and choose a blue tone. Make sure you don’t choose a highly saturated color. 
Click OK to return to the Document Window.

Choose Filter > Render > Clouds. Look over the results. Quite o�en, you may 
¢nd the saturation of the sky color is too strong. If you create a layer, you can 
easily ¢x the problem of the oversaturated sky by moving the Opacity slider 
in the Layers panel to reduce the opacity in the layer.

The advantage you have with copying and pasting a sky photo is that you 
can easily see a preview of the sky. With a ¢lter, you need to experiment and 
try di¡erent iterations of the clouds image.

In Figure 8.22, I copied a sky and pasted it into the target document. 

FIGURE 8.21 Draw around 
the correct pose (left) 
to replace it in the final 
image (right).

TIP:  If you use the Ren-
der > Clouds filter and 
you don’t like the result, 
choose the filter again. 
Keep choosing the same 
filter to see different 
patterns. You can keep 
using the same filter, 
and each time the pat-
tern changes. Choose 
the one that looks good 
to you.
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Photomerging a Panorama
This Guided Edit is used to stitch photos together from multiple photos to cre-
ate a panorama photo. Before using the Guided Edit, you should make adjust-
ments to the photos you’ll be using to make preliminary adjustments for 
brightness, contrast, and color. You can add additional edits on the merged 
photo a�er composing in the Photomerge Guided Edit.

Editing Panorama Images
If you shoot Raw images, open all photos to be merged in the Raw Editor and 
synchronize edits. Make adjustments for Exposure, Contrast, Highlights, 
Shadows, Vibrance, and Saturation. Open the photos in Expert mode in the 
Photo Editor and choose Image > Mode > 8 Bits/Channel to reduce bit depth 
for each photo. Save the ¢les; then open the Guided Edits and use the Pho-
tomerge Panorama option.

Shooting Panorama Images
If you want to take panorama images, you should always use a tripod and set your 
camera in portrait mode. You want to capture as much height in the image as pos-
sible. The panorama image will ultimately be very wide, so height is very important.

When shooting the frames, leave about ½-inch overlap between frames. If you’re 
shooting several panoramas, take a picture of your hand before the first image 
and take another photo of your hand after the last image. If you keep shooting, 
turn your hand around and take a picture of the back before and after. By the time 
you get to post processing, it will be easy to sort the photos and know what photos 
belong to what panorama.

FIGURE 8.22 The final 
image after edits to the 
sky.
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Open all images in the Photo Editor and click the Photomerge Panorama 
thumbnail in the Guided Edit panel. When you arrive at the panel, your ¢rst 
choice is to decide what setting you want. You can choose Auto Panorama 
or click the down arrow to open a pop-up menu and make a choice from the 
available options. First, choose the Auto Panorama (see Figure 8.23). If you 
don’t like the results, you can choose another option from the pop-up menu.

You can make some choices for Settings below the panorama layouts. Among 
your choices is the Content-Aware Fill Transparent Areas. You can try check-
ing this box to see how well the content-aware ¢ll handles the transparent 
areas. If you don’t like the results, you can take care of the ¢lls later when 
you open the image in the Photo Editor.

When you click Create Panorama at the bottom of the Photomerge Panorama 
panel, Elements goes about automatically creating layers and masks and 
merges the photos into a composite image. A�er merging the photos, a dialog 
box opens and prompts you to con¢rm whether you want to automatically ¢ll 
edges with content-aware ¢ll. If you click No, the merging process completes, 
and the Photomerge Panorama panel o¡ers options for sharing or opening 
the ¢le. Click Expert in the panel, and the ¢le opens in Expert mode. You see 
something similar to Figure 8.24, where the Layers, Layer Masks, and com-
posite image are shown. As you can see, I chose not to ¢ll the transparent 
areas.

FIGURE 8.23 Photomerge 
Panorama panel with Auto 
Panorama selected.
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Filling in Edges
You can choose to auto¢ll the edges when you create a composite using 
the Photomerge Panorama Guided edit. Auto¢lling edges works quite well 
in many cases. However, if there are some slight adjustments you need to 
¢nesse, it’s much easier to control the ¢lls a�er creating the composite with-
out auto¢lling the edges.

If you choose to manually ¢ll edges, start by selecting one part of the photo 
to work on. This could be half or quarter of the photo. If the photo is very 
large, Elements will perform slowly, and you may need to wait some time 
before it ¢nishes ¢lling the edges. For this example, I chose to select half the 
photo edges to perform the ¢lls in two steps.

Before selecting any area, open the Layers panel menu and choose Flatten 
Image. Save the ¯attened image. This reduces the memory, and you can per-
form steps much faster when editing a smaller photo. 

Select the area you want to ¢ll using the Magic Wand or Quick Selection tool. 
If you want to take the ¢lls-in steps, select just a part of the photo. A�er mak-
ing a selection, choose Select > Modify > Expand. Enter 5 in the Expand By 
text box to expand the selection 5 pixels. You need to grab some of the image 
edges so Content-Aware Fill will have a reference for the area to clone.

Press Shi� + Backspace/Delete to open the Fill Layer dialog box. Choose 
Content-Aware from the Use drop-down list, as shown in Figure 8.25.

Notice in Figure 8.25 that only half the photo is selected. Click OK in the Fill 
Layer dialog box and the edge is ¢lled with a clone sample of the edges. 

FIGURE 8.24 Composite 
image without edges filled.
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Check the results. If the ¢ll looks okay, move on to another part of the photo. 
Continue ¢lling the edges. If you need to polish up an edge, you might try 
using the Clone Stamp tool. In Figure 8.26, you can see the ¢nal result of 
creating a panorama image.

Other than the Panorama Exposure for HDR photos and the Photomerge 
Panorama, it may be a trade-o¡ as to whether you want to use some of the 
other Photomerge Guided Edits. The Scene Cleaner and Group Shots can be 
helpful for some quick edits. Just be certain that the perspective matches in 
all photos you merge. For more on matching perspectives, see the section 
“Understanding Perspective” earlier in this chapter.

Matching Color
Color matching is important when compositing images. If the color tempera-
ture is o¡ or color casts appear in one or the other images, the composite will 
obviously be a fake image. Your task when compositing photos is to create 
the most realistic looks.

Quite o�en, you can use the same steps for adjusting brightness and contrast, 
and the color may balance between two images in a composite photo. 

I took one photo and added a subject from another photo to create a compos-
ite, as shown in Figure 8.27.

FIGURE 8.25 Fill selections 
using content-aware fills.

FIGURE 8.26 Final pan-
orama image after using 
the Photomerge Panorama 
Guided Edit.
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I copied the subject to the background image and duplicated the subject. I 
added a Hue/Saturation Adjustment Layer and brought the Saturation slider 
to the le� to –100 to create a black-and-white copy of the subject image. 

I then added a Levels Adjustment Layer and sampled black, white, and mid-
tones in the background image and clipped the layer. Before you sample 
tones, be certain to open the Tool Options panel for the Eyedropper tool and 
choose either 3x3 or 5x5 in the Point Sample area of the Tool Options. 

Sampling Black, White, and Midtones
To sample black, white, and midtones, you first click the black Eyedropper tool in 
the Layers panel and then click in the darkest area of the image you’re sampling. 
You then click the white Eyedropper tool and sample the lightest area in the photo. 
The last sample is handled by the midtone Eyedropper tool. Click in an area where 
you can find a neutral gray.

A�er I hid the black-and-white layer, the subject color match looked fairly 
close to the color in the background, as you can see in Figure 8.28.

If the brightness adjustment isn’t quite right, you can use a very fast and easy 
adjustment for creating color balance by ¢rst duplicating the background. 
Move the background to the top of the layer stack. 

Since you don’t need the black-and-white layer anymore, you can delete it to 
make it easier to see before and a�er adjustments. Click the black-and-white 
layer, press Alt/Option, and click the Delete icon in the Layers panel to delete 
the layer. Likewise, you can delete the Hue/Saturation Adjustment layer.

FIGURE 8.27 Subject added 
to a background image.
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Select the top layer (the duplicate of the Background layer) and choose Filter 
> Blur > Gaussian Blur. In the Gaussian Blur dialog box, move the Radius 
slider far to the right. You want to blur enough to show some distinction in 
the colors but no detail.

Select the Blur layer and choose Color from the blending modes drop-down 
list.

You should always adjust brightness and contrast ¢rst when trying to color 
match photos.

As a last edit, ¯atten the layers or press Ctrl/z + Alt/Option + Shi� + E to 
create a composite layer and retain all layers in case you want to make any 
additional edits.

Adding Subjects in Grass
When you bring together photos where you show the feet of your subjects, 
you need to avoid creating composites where it appears the subject is ¯oating 
above foreground elements. In particular, grass presents a problem. When 
you drag a subject to a photo with grass in the foreground, the subject looks 
like its feet are ¯oating. A natural photo would show the feet sunken into 
the grass a little, with some grass surrounding the feet. Figure 8.29 shows 
the images I use for this example. Here are the steps to create this type of 
composite:

1. Bring a subject with a Layer Mask with the feet visible into a background 
with grass. Duplicate a selection of grass and bring it to the top of the 
layer stack. Cover the feet slightly with the grass copy.

2. Choose a brush you can use for grass. For this example, I used the 134 
brush tip shown in Figure 8.30. 

FIGURE 8.28 A close color 
match between two photos 
in a composite image.
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3. In the Tool Options panel, click Brush Settings and move the scatter 
to around 10% and the Spacing to around 20%. You can make adjust-
ments as necessary.

4. Create a new layer at the top of the layer stack. Set the blend mode to 
Multiply. 

5. Select the Brush tool. Press Alt/Option to temporarily switch to the 
Eyedropper tool. Sample a color in the grass and apply brush strokes 
to the new empty layer at the top of the layer stack. If necessary, you 
can make opacity adjustments to the layer, and you can change the 
Opacity in the Brush tool options.

In Figure 8.31, you can see the results of editing the photos shown in Figure 
8.29. 

FIGURE 8.29 Two photos to 
composite.

FIGURE 8.31 Final result of 
adding grass around the 
feet to create a more real-
istic view.

FIGURE 8.30 Brush settings to 
replicate grass.
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Analogous color scheme, 223
Angle setting (Crop tool), 42
Apple Character Viewer, 287
Apple Font Book, 287-288
applications in Photoshop 

Elements, x
artifacts, removing from lips, 412
art prints, 452-454
Asian Text, viewing, 289-290
Aspect Ratio setting (Crop tool), 42
Auto button (Camera Raw Editor), 

28
Auto Selection tool, 69-70
Avedon, Richard, 416

B
background

changing colors, 133, 442-443
colorizing, 232-234
converting to layer, 128
duplicating, 78, 128

Basic panel (Camera Raw Editor), 
26-30

Basic panel (Elements+ Camera 
Raw Editor), 56

batch processing watermarks, 
312-313

Bay Photo, 454
Before/A�er button (Camera Raw 

Editor), 25, 44
bit depth, 31, 146

8-bit vs. 16-bit, 31-33
editing work¯ow and, 98

bitmaps, converting images to, 
183

black, sampling, 215
black-and-white images

colorizing, 178-182, 242-244
converting to color, 241-242
sepia tint, 177-178

Blacks slider (Camera Raw Editor), 
30

blank layers, creating, 123

adjusting with luminosity masks
highlights, 136-138
midtones, 139-140
shadows, 136-138

Adjustment Layers. See also 
gradient maps

advantages of, 97
Brightness/Contrast, 98-99
Color Fill, sepia tint with, 177
creating, 129
in Elements+, 102-106
facial contours with, 407
gradient maps, 99-100
Hue/Saturation, 99, 383-385
inverting images, 101
Levels, sepia tint with, 177
as nondestructive, 88
Photo Filter, 100-101, 325-326
Posterize, 101-102
Selective Color, color grading 

with, 273-275
Solid Color, 325
Threshold, 101

Adjust Sharpness dialog box, 
150-151

Adobe Camera Raw (ACR). See 
Camera Raw Editor

Adobe Color. See also swatches 
(Adobe Color)

colorizing backgrounds, 
232-234

color schemes in, 223-225
exploring color themes, 

225-226
pro¢le, 50
user interface, 221-223
website location, 221

Adobe Digital Negative (DNG) ¢le 
format, 52

Adobe Landscape pro¢le, 50
Adobe Monochrome pro¢le, 50
Adobe Portrait pro¢le, 50
Adobe Sensei technology, x, 65
Adobe Standard pro¢le, 50
Adobe Vivid pro¢le, 50
Analog Efex Pro ¢lters, 9

INDEX

Symbols
1D LUTs, 275
1-pixel selections, creating, 62-63
3D LUTs

applying, 278-279
creating, 279
de¢ned, 275-276
downloading, 276
installing, 277
loading, 278
renaming, 278

8-bit images, 146
editing, 31-33
editing work¯ow, 98-99

16-bit images, 146
editing, 31-36
editing work¯ow, 98-99

18% gray cards, 266
50% gray layers, facial contours 

with, 406

A
ACR (Adobe Camera Raw). See 

Camera Raw Editor
actions, 18-19
Actions panel, 18, 177
Add a Layer Mask icon (Layers 

panel), 85
adding

borders, 385-386
color tones to vintage photos, 

378-379
e¡ects, creating layers by, 87
¢lm grain/noise, 404-405
frames, 386-388
graphics

creating layers by, 87
to Favorites panel, 234-237

styles to type, 295-297
to geometric selections, 62
to Magic Wand selections, 68
watermarks to photos, 312-313

Add Layer Mask tool, 129
Add to Favorites command 

(pro¢les context menu), 51
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C
calibration for desktop printing, 

451
Calibration panel (Camera Raw 

Editor), 43, 47
Camera Calibration tool 

(Elements+ Camera Raw Editor), 
57

Camera Data display (Camera Raw 
Editor), 41

Camera Raw Editor, x
advantages over Photo Editor, 

30-31
in Elements+ plug-in, 55-57
in Photoshop Elements 2020, 

22-39
in Photoshop Elements 2021, 

39-51
portrait editing adjustments, 

397-399
Preferences dialog box, 52-55
RAW format, 21
Save Options dialog box, 53-54
sharpening with, 145
skin tone adjustments, 421

cameras, exposure settings, 29
Cancel button (Camera Raw 

Editor), 26, 45
canvas, resizing, 367, 417
caricature e¡ects, 353

¢nal steps, 357-359
¢nishing, 357
photo preparation, 353-355
shape creation, 355-357

cartoon illustrations
caricatures, 353-359
creating, 352-353

catchlights, 409
Channel Mixer

color grading with, 271-272
in Elements+, 104-105

Channels panel (Elements+), 
selections, 76

Character Map, 287
character spacing, changing, 

289-290
Character Viewer, 287

blending options for e¡ects, 155, 
187-189

blur ¢lter for skin tones, 402-404
Blur tool, 403-404
blurring for depth of ¢eld, 166-168
body shapes, editing, 416

increasing height, 417-418
lengthening neck, 336-338, 419
with gradient mask, 417

borders
adding, 385-386
custom, 173-176
for selections, 72

bounding boxes, 303
brightness. See also luminosity 

masks
adjusting

in Curves dialog box 
(Elements+), 102-104

with gradient mask, 417
for social media, 442-443

in compositing images, 193
Contrast blend modes and, 113
matching in di¡erent photos, 

204-206
restoring faded photos, 375-376
of teeth, 414

Brightness/Contrast Adjustment 
Layers, 98-99

brows, editing, 411-412
brushes

dispersion e¡ects, 365-371
Healing Brush, restoring 

vintage photos, 378
photo e¡ects with, 342-349
Re¢ne Selection Brush, 68-69
saving, 346
Selection Brush, 67

brush sets, loading, 365
Brush Settings dialog box (Quick 

Selection tool), 66
burning

for facial contours, 407-409
in lip editing, 413

Burn tool, facial contours with, 
406

byte order, 17

blemishes, removing, 400
adding ¢lm grain/noise, 

404-405
creating selections, 400-401
editing layer masks, 402-403
re¢ning selections, 401-402
with blur ¢lter, 402-404
with Spot Healing Brush tool, 

404
blend modes

Color, 117
Color Burn, 110-111
Color Dodge, 112
Component modes, 117
in compositing images, 196
Contrast modes, 113-116
Darken, 109
Darker Color, 111
Di¡erence, 116-117
Dissolve, 108-109
Exclusion, 116
for gradient ¢lls, 92
Hard Light, 114
Hard Mix, 115-116
Hue, 117
Inversion modes, 116-117
keyboard shortcuts for, 122
Lighten, 111-112
Lighter Color, 112
Linear Burn, 111
Linear Dodge, 112
Linear Light, 115
Multiply, 110, 117-118
Normal, 108
opacity and, 111
Overlay, 113-114, 120-121
Pin Light, 115
Saturation, 117
Screen, 111, 119-120
So� Light, 114, 121-122
types of, 108
Vivid Light, 115

blending
with Layer Styles dialog box 

(Photoshop Elements), 11
with Styles dialog box 

(Elements+ plug-in), 14
Blending Mode menu (Layers 

panel), 84
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color toning. See also color 
grading

adding to vintage photos, 
378-379

cinematic color e¡ects
creating, 266-270
cropping for, 279-281

with gradient maps, 250-252
commercial plug-ins

bene¢ts of, 10-12
disabling, 15
Elements+, 12-14
Elements XXL, 15-16
trial versions, 15

commercial print shops, printing 
at, 452

Complementary color scheme, 224
Component blend modes, 117
composite layers, creating, 96-97
compositing images

blending modes, 196
brightness/contrast, 193
color balance, 195, 214-216
editing skies, 210-211
with guided edits, 203-214
lighting, 195-196
masks, 195
noise, 194
perspective, 193-202
placement, 195
purpose of, 192
resolution, 193
scale, 195
subjects in grass, 216-217

Compound color scheme, 224
compressed ¢les, expanding, 6
context menu (¢lmstrips), 48-49
context menu (pro¢les), 51
contiguous selections, creating, 

95
Contract command (Select menu), 

72
contrast

adjusting, 102-104, 417
in compositing images, 193
restoring faded photos, 375-376

Contrast blend modes, 113-116
Contrast slider (Camera Raw 

Editor), 29, 47

color channels, 104-105
color checkers, 266
Color Curves dialog box 

(Photoshop Elements), 11
Color Dodge blend mode, 112
Color Efex Pro ¢lters, 9
color e¡ects, sepia, 177-178
Color Fill adjustment layers, sepia 

tint with, 177
color grading. See also color 

toning; gradient maps
de¢ned, 238
duotones, 263-264
Elements+, 271

3D LUTs, 275-279
Channel Mixer, 271-272
Selective Color Adjustment 

Layer, 273-275
with Levels, 260-262
with So� Light blend mode, 121
vintage photos, 381-382

Colorize Photo command 
(Enhance menu), 178-180

colorizing
backgrounds, 232-234
black-and-white photos, 

178-182, 242-244
with Harry’s Filters plug-in, 9

Color Lookup dialog box 
(Elements+ plug-in), 17, 106

color lookup tables. See LUTs
color noise. See noise adjustments
Color Noise Reduction slider 

(Camera Raw Editor), 47
Color Picker, hexadecimal values 

in, 261
color pro¢le, setting for social 

media, 441
Color Range dialog box 

(Elements+), selections, 75-76
Color Replacement tool, 244-245
color schemes (Adobe Color), list 

of, 223-225
Color Settings dialog box, 441
color shi�s in infrared photos, 321
Color Swatches panel, 228
color themes (Adobe Color), 

exploring, 225-226

cinematic color e¡ects
creating, 266-270
cropping for, 279-281
orange/teal grading, 256-260

circular pixel stretch, 330-334
Clarity slider (Camera Raw Editor), 

30
Clear Layer Style command 

(Layers panel menu), 95
clipping (Camera Raw Editor)

Blacks slider, 30
de¢ned, 28
Highlights slider, 29
Highlight Warning, 41
Histogram tool, 27
Shadow Warning, 23, 41
Whites slider, 30

clipping masks, creating, 134-135
Clone Stamp tool, restoring 

vintage photos, 379-380
closing free-form selections with 

Magnetic Lasso tool, 65
Clouds ¢lter, 210-211
Collapse All Groups command 

(Layers panel menu), 94
color. See also Adobe Color

background color, changing, 
133, 442-443

byte order, 17
editing with frequency sepa-

rations, 429-432
gradient ¢lls, 90-92
lipstick colors, applying, 

412-413
out of gamut, 272
replacing with gradient maps, 

244-249
sampling with Eyedropper 

tool, 247, 421
solid color ¢lls, 89-90

color balance
in compositing images, 195, 

214-216
in Elements+, 104

Color blend mode, 117
Color Burn blend mode, 110-111
color calibration for desktop 

printing, 451
color casts, removing, 264-266, 

381
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DNG (Adobe Digital Negative) ¢le 
format, 52

DNG File Handling area (Camera 
Raw Editor Preferences dialog 
box), 52

Dodge tool, facial contours with, 
406

dodging
for facial contours, 407-409
in lip editing, 413

Done button (Camera Raw Editor), 
26, 45

Double Split Complementary color 
scheme, 224

downloading
3D LUTs, 276
color swatches, 226-227
Elements+ plug-in, 12-13
fonts, 293

dragging layers between doc-
uments, 87

dripping paint e¡ects, 349-351
duotones, 263-264
Duplicate Layer command (Layers 

panel menu), 94
duplicating

background, 78, 128
layers, 88, 123

Dust & Scratches ¢lter, restoring 
vintage photos, 377

E
edges, ¢lling in panorama 

images, 213-214
Edit tool (Camera Raw Editor), 

42-43
editing. See also Camera Raw 

Editor; Photo Editor; portrait 
editing

8-bit vs. 16-bit image work¯ow, 
98-99

Elements+ Adjustment Layers, 
104

multiple images in Camera 
Raw Editor, 33-36, 49

necessary vs. personal, 21
nondestructive, 12, 24, 31, 129

in Adjustment Layers, 88, 
97

scaling layers and, 195

Defaults drop-down list (Camera 
Raw Editor), 24

default settings (Camera Raw 
Editor)

changing with Preferences 
dialog box, 52-53

returning in Basic panel, 26-28
Defaults panel (Camera Raw 

Editor), 49
Delete Hidden Layers command 

(Layers panel menu), 94
Delete Layer command (Layers 

panel menu), 94
Delete Layer icon (Layers panel), 

85
Delete Linked Layer command 

(Layers panel menu), 94
deleting. See also removing

color swatches, 230-231
Layer Masks, 134
layers, 124

Depth button (Camera Raw 
Editor), 44

Depth drop-down list (Camera 
Raw Editor), 31-33

depth of ¢eld, 166-168
Depth tool (Camera Raw Editor), 

25
deselecting selections, 70
desktop color printers, printing 

to, 451
desktop computers, uploading 

photos to Instagram, 446-448
destructive edits, bit depth and, 

98
Detail panel (Camera Raw Editor), 

43-47
Detail slider (Camera Raw Editor), 

46-47
developer tools, accessing in web 

browsers, 447
D¢ne ¢lters, 9
Di¡erence blend mode, 116-117
disabling

fonts, 294-295
plug-ins, 15

dispersion e¡ects, 365-371
display type, 289
Dissolve blend mode, 108-109

Convert and Save Image button 
(Camera Raw Editor), 41

converting
background to layer, 128
color to black and white, 

241-242
images to bitmaps, 183
text to raster, 295
vector objects to raster objects, 

87
Convert to Black and White dialog 

box, 137
Copy Current Settings to Before 

button (Camera Raw Editor), 25
copying Layer Masks, 134
cover photo (Facebook), 448-449
Create Warped Text tool, 289
Crop Adjustments setting (Crop 

tool), 43
cropping

for cinematic color e¡ects, 
279-281

photos to square, 444-445
Crop tool

in Camera Raw Editor, 23, 42
resizing canvas, 367

curve adjustments
Color Curves dialog box 

(Photoshop Elements), 11
Curves dialog box (Elements+ 

plug-in), 13-14, 102-104
Curves dialog box (Elements+), 

13-14, 102-104
custom borders, 173-176
Custom color scheme, 224
custom grunge brushes, creating, 

345-347
customizing Line drawings 

Guided Edit pencil sketches, 
363-364

Custom Shape tool, 77-78, 309

D
Darken blend mode, 109
Darker Color blend mode, 111
Default button (Camera Raw 

Editor), 28
Default Options button (Camera 

Raw Editor), 27
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File name box (Camera Raw 
Editor), 25

¢les
opening in Camera Raw Editor, 

22
saving layers to, 37-38

Fill Layer dialog box, 88, 133
¢ll layers

creating, 88-89
gradient ¢lls, 90-92
pattern ¢lls, 92-93
solid color ¢lls, 89-90

¢lling edges in panorama images, 
213-214

¢lm grain, adding, 404-405
Filmstrip area (Camera Raw Editor 

Preferences dialog box), 53
Filmstrip Orientation command 

(¢lmstrip context menu), 49
¢lmstrips in Camera Raw Editor, 

44, 47-49
Filter menu (Camera Raw Editor), 

44
¢lters

Clouds, 210-211
Dust & Scratches, restoring 

vintage photos, 377
Liquify, 336-339
in NIK Collection plug-in, 9-10
warm, applying, 443-444

¢nding
fonts, 294
gradient libraries, 241
LUTs (color lookup tables), 16
plug-ins, 5-6

¢nishing caricatures, 357
¢xed ratio geometric selections, 

62
¢xed size geometric selections, 62
Flatten Image command (Layers 

panel menu), 96
¯attening layers, 386
Flip Horizontal tool (Camera Raw 

Editor), 23, 42
Flip Vertical tool (Camera Raw 

Editor), 23, 43
¯oating subjects, avoiding in com-

posited images, 216-217
Font Agent Pro, 294
Font Book, 287-288

comparison with Elements 
XXL plug-in, 15-16

cost of, 12
Curves dialog box, 13-14
disabling, 16
downloading, 12-13
LUTs (color lookup tables) 

with, 16-18
selections, 75-76
Smart Objects and, 107
Styles dialog box, 14

Elliptical Marquee tool, 61-62
Embed XMP in DNG command 

(Sidecars menu), 53
Enhance menu

Adjust Sharpness command, 
150-151

Colorize Photo command, 
178-180

Unsharp Mask command, 
151-152

Exclusion blend mode, 116
Expand command (Select menu), 

72
expanding compressed ¢les, 6
Expert mode (Photo Editor), x
exposure. See brightness
exposure settings in camera, 29
Exposure slider (Camera Raw 

Editor), 28
eyebrows, editing, 411-412
Eyedropper tool

Camera Raw Editor, 23
sampling with, 215, 247, 305, 

421
eyes, editing, 409-412

F
Facebook, preparing photos for, 

448-450
facial contours, 406-409
faded photos, restoring, 375-376
Favorites list for pro¢les, 51
favorites of frames, creating, 

390-391
Favorites panel, adding graphics 

to, 234-237
feathering

geometric selections, 62-64
selections, 70-71

panorama images, 211-213
skies, 210-211
vector objects, 87
vintage photos

adding frames, 386-388
borders around, 385-386
frame favorites, 390-391
frame templates, 389-390
painting Layer Mask 

frames, 388
shapes as frames, 388-389
vignettes around, 382-385

e¡ects
adding, creating layers by, 87
blending options, 155, 187-189
colorizing black-and-white 

photos, 178-182
custom borders, 173-176
depth of ¢eld, 166-168
in E¡ects (fx) panel, 155
with Elements+ plug-in, 155, 

187-189
oil paintings, 164-166
painterly images, 155-160
picture frames, 169-172
pop art, 182-184
posterizing images, 185-186
sepia, 177-178
in Styles panel, 154
vignettes, 172-173
watercolor, 160-163

E¡ects (fx) panel, 155, 177
E¡ects panel (Elements+ Camera 

Raw Editor), 57
Elements. See Photoshop 

Elements
Elements XXL plug-in, 12, 15-16
Elements+ plug-in

actions in, 18
Adjustment Layers in, 102-105
blending options for e¡ects, 

155, 187-189
Camera Raw Editor in, 55-57
color grading, 271

3D LUTs, 275-279
Channel Mixer, 271-272
Selective Color Adjustment 

Layer, 273-275
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H
hair, making fuller in portraits, 

338-339
Hand tool (Camera Raw Editor), 

23, 43-45
Hard Light blend mode, 114
Hard Mix blend mode, 115-116
Harry’s Filters plug-in, 8-9
HDR (High Dynamic Range) 

photos, 203, 207-208
HDR Efex Pro ¢lters, 9
Healing Brush tool

blemish removal, 400
editing lips, 412
restoring vintage photos, 378

height (of model), increasing, 
417-418

Help button (Camera Raw Editor), 
25, 44

Help Contents command (Layers 
panel menu), 94

hexadecimal values in Color 
Picker, 261

hiding Layer Masks, 130-131
High Dynamic Range (HDR) 

photos, 203, 207-208
high key photos, 315-320
Highlight Warning (Camera Raw 

Editor), 24, 41
highlights

adjusting with luminosity 
mask, 136-138

exposure settings in camera, 29
Highlights slider (Camera Raw 

Editor), 29
High Pass Filter, sharpening with, 

145-149
Histogram tool (Camera Raw 

Editor), 23, 27, 41
History panel (Photo Editor), 

number of history states, 70
horizon lines

in compositing images, 193-194
identifying, 197-200

horizontal pixel stretch, 327-330
HSL/Grayscale panel (Elements+ 

Camera Raw Editor), 56
Hue blend mode, 117
Hue/Saturation Adjustment 

Layers, 99, 383-385

color toning on color photos, 
250-252

colorizing black-and-white 
images, 242-244

converting color to black and 
white, 242

creating, 240-241
gradients vs., 239
loading, 241
replacing color with, 244-249
skin tone adjustments, 421-425

gradient masks, creating for body 
shape edits, 417

gradients
creating, 241
gradient maps vs., 239
for Layer Masks, 127-128

graphics, adding
creating layers by, 87
to Favorites panel, 234-237

Graphics panel, adding graphics 
to Favorites panel, 234-237

grass in composited images, 
216-217

grayscale, simulating, 183
group shots, merging, 209-210
grouping layers, 123
Grow command (Select menu), 73
grunge brushes

creating custom, 345-347
painting layer masks with, 

342-343
grunge type, creating, 306-307
guided edits, 203

duotones, 263-264
Line Drawing, 360, 363-364
painterly images, 155-156
Photomerge Compose, 203
Photomerge Exposure, 203-208
Photomerge Faces, 208
Photomerge Group Shot, 

209-210
Photomerge Panorama, 211-214
pop art, 182-183
Vignette, 382-383
watercolor e¡ect, 160-161

Guided mode (Photo Editor), x

font management tools, 294
fonts. See also text; type

de¢ned, 285
disabling, 294-295
downloading, 293
¢nding, 294
glyphs, viewing, 286-288
installing, 294
OpenType, 286
pairing, 285
sans serif, 289
serif, 288-289
slab serif, 289
TrueType, 286
TypeKit, 286

frames
adding, 386-388
favorites, creating, 390-391
Layer Mask frames, painting, 

388
purpose of, 382
shapes as, 388-389
templates for, creating, 

389-390
free-form selections, 63-65
free plug-ins, 8-10
frequency separations, 429-432
f-stops, 166
fuller hair in portraits, 338-339
Full Screen button (Camera Raw 

Editor), 23

G
General area (Camera Raw Editor 

Preferences dialog box), 52
geometric selections, 61-64
giclee prints, 452-454
glyphs, viewing, 286-288
gold type, creating, 297-299
Gradient Editor, 91-92
Gradient Fill dialog box, 90
gradient ¢lls, 90-92, 241
Gradient Filter tool (Elements+ 

Camera Raw Editor), 56
gradient libraries, ¢nding, 241
gradient maps, 99-100

adding punch to photos, 
252-256

cinematic color e¡ects with, 
256-260
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dragging between documents, 
87

duplicating, 88, 123
Elements+ Adjustment Layers, 

102-106
¯attening, 386
grouping, 123
keyboard shortcuts for, 123
Layers panel, options in, 84-86
Layers panel menu, options 

in, 94-96
merging, 123
purpose of, 83-84
raster, 77
reordering, 123-124
saving to ¢les, 37-38
scaling, 195
simplifying, 295
Smart Objects, 106-107
ungrouping, 123
vector, 77, 87

Layers Help command (Layers 
panel menu), 94

Layers panel
creating selections from 

shapes, 78-79
creating shapes, 78
duplicating background, 78
Layer Masks. See Layer Masks
options in, 84-86

Layers panel menu
creating layers, 86
options in, 94-96

layer stack, 84, 123-124
Layer Styles dialog box 

(Photoshop Elements), 11
leading, changing, 290
lengthening neck, 336-338, 419
Lens Correction tool (Elements+ 

Camera Raw Editor), 57
Levels Adjustment Layers

color grading with, 260-262
creating, 98
facial contours with, 407
sepia tint with, 177
skin tone adjustments, 425-427

levels of gray, 31

K
kerning, changing, 289-290
keyboard shortcuts

for blend modes, 122
creating composite layers, 96
creating layers, 86
for layers, 123

Keyboard Shortcuts area (Camera 
Raw Editor Preferences dialog 
box), 53

L
large format printing, 452
lashes, editing, 411-412
Lasso tools, 63-65
launching Camera Raw Editor, 

39-40
Layer Mask frames, painting, 388
Layer Masks

changing background colors, 
133

copying, 134
creating, 37, 128-130
deleting, 134
editing for portrait editing, 

402-403
gradients for, 127-128
inverting, 131
linking/unlinking, 131
painting on, 131-133, 342-343
pasting into selections, 79-80
purpose of, 127
recovering in Camera Raw 

Editor, 38-39
reusing, 343-345
saving selections, 74
showing/hiding, 130-131

Layer menu (Layers panel), 85-86
layers. See also Adjustment 

Layers; blend modes; ¢ll layers
50% gray, facial contours with, 

406
blank layers, creating, 123
composite layers, creating, 

96-97
converting background to, 128
creating, 37, 86-88
deleting, 124

I
image editing. See editing
Image window (Camera Raw 

Editor), 44
images

inverting with Adjustment 
Layers, 101

placing, 106, 195, 201
selecting in noncontiguous 

order, 48
viewing at 1:1 ratio, 45

Import Pro¢les and Presets 
command (pro¢les context 
menu), 51

infrared photos, creating, 320-324
Instagram, preparing photos for, 

441
background color, 442-443
brightness adjustments, 

442-443
color pro¢le settings, 441
cropping to square, 444-445
previewing on phone, 445
saving for web usage, 446
uploading from desktop, 

446-448
warm photo ¢lter, 443-444

installing
3D LUTs, 277
actions, 19
fonts, 294
LUTs (color lookup tables), 16
plug-ins, 6-8

intersecting with geometric 
selections, 62

inversing selections, 65, 70
Inversion blend modes, 116-117
inverting

images with Adjustment 
Layers, 101

Layer Masks, 131
selections, 70

iris (of eye), editing, 410-411
ISO settings, noise and, 194
ITPC data (Camera Raw Editor), 24
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multiple images
editing in Camera Raw Editor, 

33-36, 49
opening, 33-36

multiple textures, photo e¡ects 
with, 340-342

Multiply blend mode, 110, 117-118
My Frames panel, adding frame 

favorites to, 390-391

N
Nations Photo Lab, 454
neck (of model), lengthening, 

336-338, 419
negative masks, creating, 129
New Fill or Adjustment Layer icon 

(Layers panel), 85-86
New Group command (Layers 

panel menu), 94
New Group from Layers command 

(Layers panel menu), 94
New Group icon (Layers panel), 85
New Layer command (Layers 

panel menu), 94
New Layer dialog box, 86
New Layer icon (Layers panel), 

85-86
NIK Collection plug-in, 9-10
noise

adding, 404-405
in compositing images, 194
ISO settings and, 194

noise adjustments in Camera Raw 
Editor, 46-47

Noise Reduction slider (Camera 
Raw Editor), 47

noncontiguous order, selecting 
images in, 48

noncontiguous selections, 
creating, 95

nondestructive editing, 12, 24, 
31, 129

in Adjustment Layers, 88, 97
bit depth and, 98
scaling layers and, 195

Normal blend mode, 108

M
MacOS

expanding compressed ¢les, 6
Plug-Ins folder path, 7
screen shots in, 222

Magic Wand tool, 68
Magnetic Lasso tool, 63-65
Manage Pro¢les command 

(pro¢les context menu), 51
managing pro¢les in Camera Raw 

Editor, 51
manual pencil sketches, 360-362
Mark for Deletion command 

(¢lmstrip context menu), 49
Marquee Rectangle tool, 61-64
Masking slider (Camera Raw 

Editor), 46
masking type, 309
masks. See also Layer Masks; 

luminosity masks
clipping masks, creating, 

134-135
in compositing images, 195
purpose of, 126
Selection Brush, 67

Merge Layers command (Layers 
panel menu), 96

Merge Visible command (Layers 
panel menu), 96

merging
di¡erent photos, 204-206
group shots, 209-210
HDR photos, 207-208
layers, 123

midtones
adjusting with luminosity 

mask, 139-140
sampling, 215

model height, increasing, 417-418
Monochromatic color scheme, 223
Monotone Color panel, 177
More Image Settings menu 

(Camera Raw Editor), 43, 49
moving points in Curves dialog 

box, 102
Mpix, 453
multiple edits to single image in 

Camera Raw Editor, 36-39

libraries
for color swatches, 228
creating in Preset Manager, 231
gradient libraries, ¢nding, 241

Lighten blend mode, 111-112
Lighter Color blend mode, 112
lighting

catchlights, 409
in compositing images, 195-196

Linear Burn blend mode, 111
Linear Dodge blend mode, 112
Linear Light blend mode, 115
Line Drawings Guided Edit, 360, 

363-364
liner (of eye), editing, 411-412
line spacing, changing, 289-290
Link Layers command (Layers 

panel menu), 95
linking Layer Masks, 131
lips, editing, 412-413
lipstick colors, applying, 412-413
Liquify ¢lter, 336-339
Load Selection dialog box, 74
loading

3D LUTs, 278
brush sets, 365
color swatches, 228-230
gradient maps, 241
selections in Channels panel 

(Elements+), 76
Lock All Pixels icon (Layers 

panel), 85
Lock All Transparent Pixels icon 

(Layers panel), 85
lookup tables (LUTs), 106
low key photos, 315-317
low poly illustrations, 334-336
luminosity masks, 433-436

highlights/shadows, 136-138
midtones, 139-140
purpose of, 136

LUTs (color lookup tables), 106
3D LUTs, 276-279
de¢ned, 16, 275-276
with Elements+ plug-in, 16-18
installing, 16
Photoshop 3DLUTs folder, 16
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pencil sketches, 360-364
with Photo Filter Adjustment 

Layer, 325-326
pixel stretch, 327-334
vintage photos, 391-394

Photo E¡ects panel (Elements+ 
plug-in), 188-189

Photo Filter Adjustment Layer, 
100-101, 325-326

Photomerge Compose guided edit, 
203

Photomerge Exposure guided edit, 
203-208

Photomerge Faces guided edit, 
208

Photomerge Group Shot guided 
edit, 209-210

Photomerge Panorama guided 
edit, 211-214

photos. See images
Photoshop 3DLUTs folder, 16
Photoshop Elements, applications 

in, x
Photoshop Elements 2020, Camera 

Raw Editor in, 22
Basic panel, 26-30
Depth drop-down list, 31-33
multiple edits to single image, 

36-39
multiple images, editing, 33-36
opening ¢les, 22
tools and panels, 23-26

Photoshop Elements 2021, Camera 
Raw Editor in

Calibration panel, 47
¢lmstrips, 47-49
launching, 39-40
multiple images, editing, 49
noise adjustments, 46-47
pro¢les, 50-51
sharpening images, 45-46
tools and panels, 40-45

picture frames, 169-172
Pin Light blend mode, 115
pixel stretch

circular, 330-334
horizontal, 327-330

Place command (Photo Editor), 195

pasting
data, creating layers by, 87
into selections, 79-80

paths
selections from, 77
type on, 309-312

Paths panel, 12
Pattern Fill dialog box, 92
pattern ¢lls, 92-93
Patterns dialog box, 93
pencil sketches, 360

customizing Line Drawings 
Guided Edit, 363-364

manual creation, 360-362
Pen tool, 12
perspective in compositing 

images, 193-196
identifying horizon line, 

197-200
placing images, 201
scaling images, 201-202
vanishing point types, 198-199

phones, previewing photos on, 
445

Photo Editor, x
actions, 18-19
Camera Raw Editor advantages 

over, 30-31
History panel, number of 

history states, 70
LUTs (color lookup tables). See 

LUTs
multiple images, opening, 

34-36
Select menu, 70-74
sharpening with, 150-153
workspaces in, x

photo e¡ects. See also portrait 
editing

with brushes, 342-349
cartoon illustrations, 352-359
dispersion, 365-371
high key photos, 315-320
infrared photos, creating, 

320-324
low key photos, 315-317
low poly illustrations, 334-336
with multiple textures, 340-342
paint drips, 349-351

O
oil painting e¡ect, 164-166
one-point vanishing points, 198
online printing services, printing 

with, 452-454
opacity

blend modes and, 111
of photo ¢lters, 325

Opacity adjustment slider (Layers 
panel), 85

Open button (Camera Raw Editor), 
45

Open Copy button (Camera Raw 
Editor), 26, 45

Open Image button (Camera Raw 
Editor), 26

Open Preferences button (Camera 
Raw Editor), 41

opening
¢les in Camera Raw Editor, 22
multiple images, 33-36

OpenType fonts, 286
orange/teal color grading, 187-188, 

256-260
Organizer, x, 33
orientation of ¢lmstrips, 

changing, 48
out of gamut colors, 272
Overlay blend mode, 113-114, 

120-121
oversized prints, 452

P
paint drip e¡ects, 349-351
painterly image e¡ect, 155-160
painting

for colorizing photos, 180-182
Layer Mask frames, 388
on Layer Masks, 131-133

pairing fonts, 285
Panel Bin (Camera Raw Editor), 

24, 40, 43
panel icons (Camera Raw Editor), 

24
Panel Options command (Layers 

panel menu), 96
Panels area (Camera Raw Editor 

Preferences dialog box), 53
panorama images, 211-214
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replacing
color with gradient maps, 

244-249
color swatches, 230

reselecting selections, 70
Reset button (Camera Raw Editor), 

26, 45
Reset Favorite Pro¢les command 

(pro¢les context menu), 51
Reset Hidden Pro¢les command 

(pro¢les context menu), 51
resizing

canvas, 367
for cover photo (Facebook), 

448-449
resolution

in compositing images, 193
of cover photo (Facebook), 449
scanning text, 101

restoring vintage photos, 375
adding color tones, 378-379
with Clone Stamp tool, 379-380
with Dust & Scratches ¢lter, 

377
faded photos, 375-376
with Healing Brush tool, 378
removing color casts, 381

reusing layer masks, 343-345
Rotate Le� tool (Camera Raw 

Editor), 23, 42
Rotate Right tool (Camera Raw 

Editor), 23, 42
rotating type, 291
rounded corners, creating on 

selections, 64
running actions, 19

S
sampling color with Eyedropper 

tool, 215, 247, 305, 421
sans serif fonts, 289
Saturation blend mode, 117
Saturation slider (Camera Raw 

Editor), 30
Save for Web dialog box, 185, 446
Save Image dialog box (Camera 

Raw Editor), 25
Save Options dialog box (Camera 

Raw Editor), 41, 53-54

printing photos, 451-454
Process Multiple Files dialog box, 

312-313
Pro DPI, 453
Pro¢le Info command (pro¢les 

context menu), 51
pro¢les in Camera Raw Editor, 

50-51
Pro¢les tool (Camera Raw Editor), 

24, 27, 43

Q
Quick mode (Photo Editor), x
Quick Selection tool, 65-66
Quote Graphic feature, 291-293

R
Radius slider (Camera Raw 

Editor), 46
raster

converting
text to, 295
vector objects to, 87

vector vs., 77
warping type, 302-304

RAW format, 21
recovering layer masks in Camera 

Raw Editor, 38-39
red carpet photo booth example, 

348-349
Red Eye Removal tool (Camera 

Raw Editor), 23, 43
Re¢ne Edge dialog box, 71
Re¢ne Selection Brush tool, 68-69
re¢ning selections, 70-73, 401-402
re¯ections for type, 307-308
reloading selections, 74
Remove from Favorites command 

(pro¢les context menu), 51
removing. See also deleting

artifacts from lips, 412
blemishes, 400-405
color casts, 264-266, 381

Rename Layer command (Layers 
panel menu), 94

renaming 3D LUTs, 278
reordering layers, 123-124
Replace Layer Mask dialog box, 

134

placing
objects, creating layers by, 87
photos, 106, 195, 201

plug-ins
commercial, 10-16
de¢ned, 5
¢nding, 5-6
free, 8-10
installing, 6-7

points, moving in Curves dialog 
box, 102

Polygonal Lasso tool, 63-65
polygons in low poly illustrations, 

334-336
pop art e¡ects, 182-184
portrait editing, 397. See also 

photo e¡ects
blemish removal, 400-405
body shapes, 336-338, 416-419
Camera Raw adjustments, 

397-399
eyes, 409-412
facial contours, 406-409
with frequency separations, 

429-432
fuller hair, 338-339
lips, 412-413
with Luminosity Masks, 

433-436
sharpening, 414-416
skin tones, 421-427
smoothing skin, 427-429
teeth brightening, 414

Posterize Adjustment Layers, 
101-102

posterizing e¡ect, 185-186
Preferences dialog box (Camera 

Raw Editor), 23, 52-55
preparing photos

for caricatures, 353-355
for social media. See sharing 

photos
Preset Manager

color swatch management, 231
loading brush sets, 365
saving brushes, 346

Presets tool (Elements+ Camera 
Raw Editor), 57

previewing photos on phone, 445
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sharpening
with Camera Raw Editor, 

45-46, 145
with High Pass Filter, 145-149
with Photo Editor, 150-153
portraits, 398, 414-416
separate image areas, 148-149

Sharpening slider (Camera Raw 
Editor), 46

shooting panorama images, 211
Show Filename command 

(¢lmstrip context menu), 49
Show Ratings & Color Labels 

command (¢lmstrip context 
menu), 49

Show/Hide Filmstrip button 
(Camera Raw Editor), 44

showing Layer Masks, 130-131
sidecar ¢les, XMP ¢le format, 

53-55
Silver Efex Pro ¢lters, 10
Similar command (Select menu), 

73
Simplify Layer command (Layers 

panel menu), 94
simplifying

layers, 295
vector layers, 87

Single Column Marquee tool, 
62-63

Single Row Marquee tool, 62-63
sizing type, 290-291
sketches. See pencil sketches
skies, editing, 210-211
skin, smoothing, 427-429
skin tone charts, 425
skin tones

blur ¢lter for, 402-404
editing, 421-427
selections for, 400-402
sharpening, 415

slab serif fonts, 289
Smart Blur dialog box, 402
Smart Objects, 12

with Elements+, 107
in Elements+ Camera Raw 

Editor, 57
for placing images, 201
placing photos as, 106

feathering, 70-71
free-form, 63-65
geometric, 61-64
inversing, 65, 70
inverting, 70
noncontiguous, creating, 95
pasting into, 79-80
from paths, 77
re¢ning, 70-73, 401-402
reloading, 74
reselecting, 70
saving, 73-74
straight-line, 64
subjects, 65, 71-72
transforming, 73

Selective Color Adjustment 
Layers, 105, 273-275

Sensei technology, x
sepia e¡ects, 177-178
serif fonts, 288-289
Set Rating command (¢lmstrip 

context menu), 49
Shades color scheme, 224
shadows

adjusting with luminosity 
mask, 136-138

in compositing images, 195-196
exposure settings in camera, 

29
for type, 307-308

Shadows slider (Camera Raw 
Editor), 29

Shadow Warning (Camera Raw 
Editor), 23, 41

shapes
creating, 77-78

for caricatures, 355-357
layers from, 87
selections from, 78-79

as frames, 388-389
type on, 309-312

sharing photos
via Facebook, 448-450
via Instagram, 441-448
via Twitter, 450-451

Sharpen tool, 152-153
Sharpener Pro ¢lters, 10

Save Selection dialog box, 73
saving

brushes, 346
color swatches, 230
layers to ¢les, 37-38
photos for Instagram, 446
screen shots, 223
selections, 73-74

scale in compositing images, 195
scaling

images, 201-202
layers, 195
with Smart Objects, 106
type, 290-291

scanning text, 101
sclera (of eye), 409-411
Screen blend mode, 111, 119-120
screen shots, 222-223
Select All command (¢lmstrip 

context menu), 48
Select Linked Layers command 

(Layers panel menu), 95
Select menu (Photo Editor), 70-74
Select Subject button (Quick 

Selection tool), 65
selecting images in noncon-

tiguous order, 48
Selection Brush tool, 67
Selection tools

Auto Selection, 69-70
free-form selections, 63-65
geometric selections, 61-64
in Tools panel, 61
Magic Wand, 68
Quick Selection, 65-66
Re¢ne Selection Brush, 68-69
Selection Brush, 67
straight-line selections, 64

selections. See also Selection 
tools; Select menu (Photo Editor)

borders for, 72
contiguous, creating, 95
creating

Layer Masks from, 130
from shapes, 78-79
for skin tones, 400-401

deselecting, 70
in Elements+ plug-in, 75-76
entire canvas, 70
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Toggle Between Current Settings 
and Defaults button (Camera 
Raw Editor), 25, 44

Toggle Full Screen Mode button 
(Camera Raw Editor), 42

Tone Curve tool (Elements+ 
Camera Raw Editor), 56

Tools panel
Selection tools in, 61
Sharpen tool, 152-153

tracking, changing, 289-290
transforming selections, 73
Transform tool (Elements+ 

Camera Raw Editor), 57
Treatment tool (Camera Raw 

Editor), 24, 27
Triad color scheme, 223
trial versions of plug-ins, 15
TrueType fonts, 286
Twitter, preparing photos for, 

450-451
two-point vanishing points, 

198-199
type. See also fonts; text

adding styles, 295-297
display type, 289
e¡ects

gold type, 297-299
grunge type, 306-307
masking type, 309
shadows and re¡ections, 

307-308
splitting type, 299-300
on stone, 304-305
with Style Settings dialog 

box, 295-297
warping type, 300-304
on wood, 305-306

rotating, 291
scaling, 290-291
on shapes/paths, 309-312
spacing of, changing, 289-290
text type, 289
viewing samples, 291-293

Type Tool Options panel, warping 
type, 300-302

typefaces, de¢ned, 285
TypeKit, 286

subjects in selections, 65, 71-72
subjects in grass in composited 

images, 216-217
subtracting from geometric 

selections, 62
Surface Blur ¢lter, 402
Swap Before/A�er Settings button 

(Camera Raw Editor), 25
swatches (Adobe Color)

deleting, 230-231
downloading, 226-227
libraries for, 228
loading, 228-230
managing in Preset Manager, 

231
replacing, 230
saving, 230
uploading photos for, 227-228

T
tarpaulin prints, 452
teal/orange color grading, 256-260
teeth, brightening, 414
Temperature slider (Camera Raw 

Editor), 24, 28
templates for frames, creating, 

389-390
text. See also fonts; type

converting to raster, 295
creating layers from, 87
scanning, 101
as watermarks, 312-313

Text on Custom Path tool, 309
Text on Shape tool, 309
text type, 289
textures

applying multiple, 340-342
editing with frequency sepa-

rations, 429-432
oil painting e¡ect with, 

164-166
Texturizer, oil painting e¡ect 

with, 164-166
The Plugin Site, 5-8
Threshold Adjustment Layers, 101
Tint slider (Camera Raw Editor), 

24, 28

purpose of, 106
scale and, 195

Smooth command (Select menu), 
72

Smooth Skin dialog box, 428-429
smoothing skin, 427-429
Smoothness slider (Camera Raw 

Editor), 47
social media. See sharing photos
So� Light blend mode, 114, 121-122
Solid Color Adjustment Layer, 325
solid color ¢lls, 89-90
Sort menu (Camera Raw Editor), 

44
spacing of type, changing, 

289-290
Split Complementary color 

scheme, 224
Split Toning tool (Elements+ 

Camera Raw Editor), 57
splitting type, 299-300
Spot Healing brush, blemish 

removal, 400, 404
square, cropping photos to, 

444-445
Square color scheme, 224
star ratings (Camera Raw Editor), 

44
stone, type on, 304-305
stops

in actions, 19
for gradient ¢lls, 91

Straighten tool (Camera Raw 
Editor), 23, 42

straight-line selections, 64
styles

adding to type, 295-297
for gradient ¢lls, 91
Layer Styles dialog box 

(Photoshop Elements), 
blending with, 11

Styles dialog box (Elements+ 
plug-in), blending with, 14

Styles dialog box (Elements+ 
plug-in), 14

Style Settings dialog box, 295-297
Styles panel

e¡ects in, 154
Layer Styles dialog box, 11
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editing
adding frames, 386-388
borders around, 385-386
frame favorites, 390-391
frame templates, 389-390
painted Layer Mask frames, 

388
shapes as frames, 388-389
vignettes around, 382-385

Multiple blend mode, 118
restoring, 375

adding color tones, 378-379
with Clone Stamp tool, 

379-380
with Dust & Scratches £lter, 

377
faded photos, 375-376
with Healing Brush tool, 378
removing color casts, 381

Visibility icon (Layers panel), 86
Viveza ¢lters, 10
Vivid Light blend mode, 115
vividness, adding to photos, 

252-256

W
warm photo ¢lter, applying, 

443-444
warping type, 300-304
Warp Transformation tool, 

302-304
watercolor e¡ect, 160-163

U
ungrouping layers, 123
unlinking Layer Masks, 131
Unsharp Mask dialog box, 151-152
uploading photos

for color swatches, 227-228
cover photo (Facebook), 450
to Instagram, 446-448

upsizing images for printing, 452

V
vanishing points, types of, 

198-199
vector layers

raster vs., 77
simplifying, 87

vector objects, 87
vector shapes, text as, 295
vector type, warping, 300-302
Vertical Type tool, 291
Vibrance slider (Camera Raw 

Editor), 30
viewing

Asian Text, 289-290
glyphs, 286-288
images at 1:1 ratio, 45
type samples, 291-293

Vignette Guided Edit, 382-383
vignettes, 172-173, 382-385
vintage photos

color grading, 381-382
creating look of, 391-394

watermarks, adding to photos, 
312-313

web browsers, developer tools 
in, 447

websites for fonts, 294
WHCC, 453
white, sampling, 215
white balance, Eyedropper tool 

(Camera Raw Editor), 23
White Balance slider (Camera Raw 

Editor), 24, 28
Whites slider (Camera Raw 

Editor), 30
Windows, 6, 222
Windows Character Map, 287
wood, type on, 305-306
workspaces in Photo Editor, x

X–Y–Z
XMP ¢le format, 53-55

Zoom and Pan area (Camera Raw 
Editor Preferences dialog box), 
53

Zoom tool (Camera Raw Editor), 
23-24, 43-45
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